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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground.

The TReK HPEG application provides the capability to access the Huntsville Operations
Support Center (HOSC) Payload Ethernet Gateway (HPEG) service.

1.1 Getting Started

Start with the Introduction which provides an application overview. Next, try the Quick
Start Guides for “How Tos” for common functions. For help with details, reference the

Details section. See the FAQ and Troubleshooting section for helpful hints and solutions
to the common “‘gotchas”.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone:  256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time)
Fax: 256-544-9353

If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
mail message is automatically forwarded to the TReK developers and helps cut the
response time. The HOSC Help Desk (256-544-5066) can provide assistance as needed
and is available 24x7.

3 Introduction

The TReK HPEG application provides the capability to access the Huntsville Operations
Support Center (HOSC) Payload Ethernet Gateway (HPEG) service. The HPEG service
provides access to payloads onboard the International Space Station (ISS) using standard
network protocols and services. Services supported include:

Ping over ICMP

Hypertext Transfer Protocol Secure (https) over TCP on port 443
Remote Desktop (rdp) over TCP on port 3389

Secure Shell (ssh) over TCP on port 22

CCSDS File Delivery Protocol (cfdp) over UDP on port 4560

YVVVVY
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Delay Tolerant Network (dtn) over TCP on a configured port

Note: In the event this list does not match the Payload to Generic User Interface
Definition Document (PGUIDD) SSP 50305, the information in the PGUIDD takes
precedent.

Access to these services is based on HOSC account privileges.

The general sequence of events when using HPEG is as follows:

VVVVY VYV

>

Establish VPN session with HOSC.

Establish a Login Session with the HOSC using the TReK HOSC Login
application.

Start the TReK HPEG application.

Push the Configure button to configure the application.

Push the Activate button to activate the HPEG service.

Once the HPEG service is active, starta session with your destination (payload).
Use the Ground Proxy IP address returned to communicate with your payload
using other products such as the TReK CFDP application, Remote Desktop, a
console command line to ssh, etc.

When finished Deactivate and EXxit.

The interface between the TReK HPEG application and the HOSC is shown in Figure 1.

Huntsville Operations | HPEG Communication
Support Center (HOSC)

TReK HPEG
< > Application
(trek_hpeg)

Figure 1 TReK HPEG/HOSC Communication

Figure 2 shows the standard IP communication that is possible between ground
applications and flight applications once HPEG services have been started.

1SS Payload Ground Application
Application _ Standard IP Protocols PP
Onboard 155 B - (ssh, ping, etc)

Figure 2 Standard IP Communication
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4 Overview of the User Interface

4.1 Main Window

The main window is shown in Figure 3. The Message area is a dock window that you
can float or dock. To float a dock window, use your left mouse button to click and hold
the title area while dragging the window to another area of the screen. To dock, use the
title bar to drag the dock window over the main window and drop.

.- TReK HPEG — O X
File View HPEG Options Help

Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Increment:  Operational Mode:  Idle Chedk: Enable Dizable

Destination Enablement Forward Link Return Link  Location Status  Ground Proxy [P Message Space Node ID

Start Session | Stop Session

Mezzage Area (-4

Ready

Figure 3 Main Window

Configuration Toolbar
The Configuration toolbar at the top of the window provides quick access to configure
the application, activate, and deactivate the HPEG service.

HPEG Toolbar

The HPEG toolbar (located under the Configuration toolbar) provides quick access to
HPEG Status and Configuration information. It also provides the capability to Enable
and Disable the HPEG ldle Check capability.

Ground Node 1D Toolbar

The Ground Node ID Toolbar (located under the HPEG toolbar when displayed) provides
quick access to the Ground Node ID. If you do not have a Ground Node ID assigned, this
toolbar will not be displayed. The Ground Node ID toolbar is only displayed when the
HPEG service is active and a Ground Node ID is in use. This toolbar will also display
Delay Tolerant Network information if you have access to this service.

HPEG

The HPEG area provides a list of “Destinations” you are authorized to access through the
HPEG. Typically you will have one destination in the list — your payload. The HPEG
area also provides “Start Session” and “Stop Session” buttons to start and stop an HPEG
session for a selected destination. If you are authorized to use the CFDP service or the
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DTN service, you will be assigned a Ground Node 1D, and your payload onboard will be
assigned a Space Node ID. These IDs correspond to CFDP Entity IDs (EIDs) needed by
the CFDP protocol and the DTN node number when using DTN. If you are authorized to
use the CFDP service or DTN service, you will be prompted to select your Ground Node
ID during HPEG activation. It is possible to have more than one Ground Node ID
assigned. In this case you will be prompted with a list and can select the Ground Node
ID you would like to use for the session. If you are not authorized to use the CFDP
service or the DTN service, you will not be prompted for a Ground Node ID and the
Space Node ID field will always be empty.

If you are authorized to use the CFDP service or DTN service, you must select a Ground
Node ID when prompted. If you select a Ground Node ID that is in use, you will be
prompted again. If all Ground Node IDs are in use, you will need to free one of the
Ground Node IDs so you can select one that is available or cancel the activation.

Message Area
The Message Area displays important information, warning and error messages. The

message area can be cleared using the View menu.

4.2 Toolbars

There are three toolbars: Configuration, HPEG and Ground Node ID. The Configuration
toolbar provides visual information about the state of the application and provides access
to common application functions. The HPEG toolbar provides HPEG Configuration and
Status information. The Ground Node ID toolbar provides access to the Ground Node ID
selected during activation and DTN configuration information if you are authorized to
use the DTN service.

4.2.1 Configuration Toolbar

The Configuration toolbar is shown in Figure 4. It canbe used to configure the
application, activate the HPEG service, and deactivate the HPEG service.

Configuration: . Configure | Operational . Activate Deactivate

Figure 4 Configuration Toolbar

Configuration Status

When the Configuration status is black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the HPEG service can be activated.

Use the Configure button to access the Configuration dialog to configure the application.

Operational Status
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When the Operational status is black, this indicates the HPEG service is inactive. When
the Operational status is purple, activation is in progress. When the Operational status is
green, this indicates the HPEG service is active. The application must be properly
configured before the Activate button will be available. The HPEG service must be
active before the Deactivate button will be available.

Use the Activate button to activate the HPEG service. This will initiate all internal
activities needed to prepare the application to support the HPEG service. If you need to
reconfigure the HPEG application, deactivate the HPEG service, and then push the
Configure button to reconfigure.

4.2.2 HPEG Toolbar

The HPEG toolbar is shown in Figure 5 and Figure 6. When the HPEG service is
Inactive, the HPEG Toolbar will not contain any HPEG Status and Configuration
information. When the HPEG service is activated, the HPEG Toolbar will display HPEG
Status and Configuration information. For details about HPEG Status and Configuration
information please reference Section 6.2. The HPEG Toolbar also provides the capability
to Enable and Disable the HPEG Idle Check. This feature is only available when the
HPEG service is active.

HPEG User:  Increment:  Operational Mode:  Idle Chedk: Enable Disable

Figure 5 HPEG Toolbar

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Chedk: Enabled Enable Disable

Figure 6 HPEG Toolbar Populated

4.2.3 Ground Node ID Toolbar

The Ground Node ID Toolbar is shown in Figure 7. This toolbar provides quick access
to the Ground Node ID. If you do not have a Ground Node ID assigned, this toolbar will
not be displayed. The Ground Node ID toolbar is only displayed when the HPEG service
is active and a Ground Node ID is in use. If you are authorized to use the DTN service,
the Ground Node ID Toolbar will also display DTN configuration information as shown
in Figure 8.

Ground Mode ID: 345

Figure 7 Ground Node ID Toolbar



TREK-USER-0005

Ground Node ID: 345 HOSC DTN Mode Number: 65535 HOSC DTN Mode IP Address: 192, 168,100,101 HOSC DTN Node Port: 2014

Figure 8 Ground Node ID Toolbar with DTN Configuration Information

4.3 Menus

The HPEG application menus are: File, View, HPEG, Options, and Help. Each of these
menus is described in more detail below.

File Menu
The File menu provides the capability to exit the application.

View Menu
The View menu provides the capability to clear the main window message area and show
and hide the main window message area.

HPEG Menu
The HPEG menu provides the capability to configure the application, activate and
deactivate the HPEG service, and show HPEG messages.

Options Menu
The Options menu provides access to the Messages dialog which can be used to display

and filter application messages. Access toadvanced settings is also available.

Help Menu
The Help menu provides access to on-line help and application version information.

5 Quick Start Guides

This section provides “How Tos” for common functions.

5.1 How to Configure the Application

The following steps describe the minimum necessary to configure the application. For
additional information and details about the Configure dialog please reference section
6.1.

1. Push the Configure button to display the Configure dialog.

2. Enter the name of an active HOSC Login Session that was created using the TReK
HOSC Login application.

3. Enter a Local IP Address.
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Note: If you are connecting to the HOSC, enter the Office Mode IP Address returned
by the HOSC VPN client in the Local IP Address field.

Enter a port number that may be used for communication between TReK and the
HOSC about HPEG.
Push the OK button to save the configuration information and exit the dialog.

Note: If your site requires Firewall Network Address Translation, use the Firewall
(NAT) tab to enter this information.

If the application is configured correctly, the Configuration status will be green.

5.2 How to Start and Stop the HPEG Service
This section describes how to start (activate) and stop (deactivate) the HPEG service.

1.

w

Before the HPEG service can be started, you must configure the application. To learn
more about this see section 5.1. The Configure status must be green before you can
start the HPEG service.

To start the HPEG service, push the Activate button on the Configuration toolbar.
The activation process will initiate a POIC login and request the HPEG service. If
this is successful the Operational status will turn green, the HPEG toolbar will be
populated with HPEG Configuration and Status information, and you will see a list of
authorized destinations in the HPEG area.

To stop the HPEG service, push the Deactivate button.

When activating or deactivating important status and/or error messages will be
displayed in the Main Window message area.

5.3 Howto Start a Session with a Destination
This section describes how to start a session with a destination.

1.
2.

The HPEG application must be configured and the HPEG service must be active.
Select an Inactive Destination in the HPEG area and push the Start Session button.
This will send a request to the POIC to start a session for the destination. If this is
successful, the destination’s Status column will show Active and the Ground Proxy IP
Address will be displayed in the Ground Proxy IP column. If you have a Space Node
ID, it will be shown in the Space Node ID column. You will also see a message in
the Message column indicating the status of your “Start Session” request.
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TReK HPEG

File View HPEG Options Help
Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Cheds: Enabled Enable Disable

Ground Mode ID: 345 HOSC DTN Mode Mumber: 65535 HOSC DTN Node IP Address: 192,168, 100,101 HOSC DTM Mode Port: 2014

Destination Enablement Forward Link Return Link Location Status  Ground Proxy [P Message Space Node D
MylssPayload Enabled LOS AOS 155 Inactive 1.2.3.4
SomewhereOverTheRainbow Disabled N/A N/A lcarus  Inactive 2001

Start Session | Stop Session

Message Area g X

GMT 2019-07-22 11:51:21:644 Info: Interfacing with EHS Build Version 31.1.2

GMT 2019-07-22 11:51:22:1591 Info: Accepted connection for Socket 1.2, 156,68, 128, 186.8819. 3 IP Address: 156.68,128, 186 Port: 56622
GMT 2019-07-22 11:51:23:495 Info: User selected COnboard Proxy IP 20,16, 13.82

GMT 2013-07-22 11:51:23:495 Info: User selected Ground Mode ID 345

GMT 2019-07-22 11:51:23:510 Info: Successfully activated support for HPEG.

HPEG Active

Figure 9 Inactive Destination

.. TReK HPEG

File View HPEG Options Help
Configuration: . Configure | Operational . Activate Deactivate

HPEG User: Enabled Increment: 41 Operational Mode: Flight Idle Check: Enabled Enable Disable

Ground Node ID: 345 HOSC DTN Mode Number: 65535 HOSC DTN Node IP Address: 192,168, 100,101 HOSC DTN Mode Port: 2014

Destination Enablement Forward Link Return Link Location Status  Ground Proxy [P Message Space Node ID
MylssPayload Enabled LOS AOS 155 Active  192,168.1.25 Successfully Initialized (0): Success!
SomewhereQverTheRainbow Disabled N/A N/A Icarus Inactive 2001

Start Session | | Stop Session
Message Area g X

GMT 2019-07-22 11:51:21:644 Info: Interfacing with EHS Build Version 31.1.2

GMT 2019-07-22 11:51:22: 191 Info: Accepted connection for Socket 1.2, 156,68, 128, 186.8819.3 IP Address: 156.68. 128,186 Port: 56622
GMT 2019-07-22 11:51:23:495 Info: User selected Onboard Proxy IP 20,16,13.82

GMT 2019-07-22 11:51:23:495 Info: User selected Ground Node ID 345

GMT 2019-07-22 11:51:23:510 Info: Successfully activated support for HPEG.

HPEG Active

Figure 10 Active Destination

5.4 How to Stop a Session with a Destination
This section describes how to stop a session with a destination.

1. The HPEG application must be configured and the HPEG service must be active.

2. Select an “Active” Destination in the HPEG area and push the Stop Session button.
This will send a request to the POIC to stop the session for that destination. If this is
successful, the destination’s Status column will show Inactive and the Ground Proxy
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IP column will be blank. You will also see a message in the Message column
indicating the status of your “Stop Session” request.

5.5 How to Enable and Disable the HPEG Idle Check

The Enable and Disable buttons on the HPEG toolbar can be used to control the HPEG
Idle Check. Ifyou disable the HPEG ldle check, you will not be prompted when your
HPEG session has been idle for a HOSC configured amount of time.

6 Details
This section covers various application details.

6.1 Configuration

The HPEG Configuration dialog contains two tabs: General and Firewall (NAT). The
General tab is used to provide information needed for TReK to communicate with the
HOSC about HPEG. The Firewall (NAT) tab can be used to enter configuration
information for locations using a firewall with network address translation.

6.1.1 General Tab
The General tab is shown in Figure 11. Eachfield is described below.

HPEG Configuration

HOSC Login Mame: | | | Browse... I

General Firewall (MAT)

Local IP Address: | | Browse. ..

Local Port: |aa 19 |

oK, Cancel

Figure 11 HPEG Configuration Dialog (General Tab)

HOSC Login Name
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This field should contain the name of an active HOSC Login Session that was created
using the TReK HOSC Login application. The Browse button can be used to view and
select a HOSC Login Name.

Local IP_ Address
This field should contain your local IP address.

Port
A TCP socket is created to send and receive HPEG information between TReK and the
HOSC. The Local IP Address and port are used to create this TCP socket.

6.1.2 Firewall (NAT) Tab
The Firewall tab is shown in Figure 12. Each field is described below.

Ml HPEG Configuration ? =

HOSC Login Mame: || Browse...

General Firewall (MAT)

[] Firewall In Use (Metwork Address Translation Meeded)

rewall TB Addre .
ewall IF AQdress,

vall Port:

i

Cancel

Figure 12 HPEG Configuration Dialog (Firewall Tab)

Firewall In Use (Network Address Translation Needed)
Check the “Firewall In Use” checkbox, if your location is using a Firewall with network
address translation.

Firewall 1P Address
The Firewall IP Address.

Firewall HPEG Port
The Port on the Firewall that should be used for HPEG traffic.

10
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6.2 HPEG Configuration and Status
This section describes the items in the main window HPEG toolbar.

HPEG User
This indicates if your user account is Enabled or Disabled for HPEG.

Increment
This displays the increment you are logged into.

Operational Mode
This displays the operational mode you are logged into.

Idle Check

This indicates if the HPEG Idle Check is Enabled or Disabled. If you push the Enable
button the Idle Check will be enabled. If you push the Disable button, the Idle Check
will be disabled. If the Idle Check is disabled, the POIC will not monitor the HPEG
sessions to determine if any have gone idle.

6.3 HPEG Messages

The HPEG Messages dialog is shown in Figure 13. Itis available from the HPEG menu.
This dialog displays HPEG messages associated with HPEG Destinations.

.. HPEG Messages ? *

GMT 2019-02-27 20:08:47 MylssPayload: Successfully Initialized (0): Success!

Clear

Figure 13 HPEG Messages

6.4 Application Messages

Various types of application messages are generated including information, progress,
warning, error, and debug messages. Application messages are stored in memory and
written to a temporary log file. The temporary log file is created on application
initialization and exists as long as the application is running. It is deleted when you exit
the application. The log file is located in the temporary directory provided by the
operating system. Only a subset of messages are stored in memory while all messages
are written to the temporary log file. The maximum number of application messages

11
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stored in memory is controlled by the message storage setting in the Configure Messages
dialog. Once the maximum is reached, older messages are deleted to make room for new
messages. Setting the maximum value to a large number can impact application
performance since it will increase the amount of memory used by the application. Setting
this number too low can cause you to miss important messages. The application default
was selected to protect against both of these scenarios. Messages stored in memory are
displayed in the Main Window Message Area and the Messages dialog. The Messages
dialog is shown in Figure 14. The Main Window message area only displays Info,
Warning, and Error messages. The Messages dialog displays messages based on the
display preferences defined in the Configure Messages dialog. By default, the Messages
dialog will display information, progress, warning, and error messages. Columns in the
Messages dialog can be sorted by clicking on the column header. The Messages dialog is
available from the Options menu.

..\ Messages 7

Time

Category

{GMT 2020-01-29 12:37:30:344

Info

Mezzage 2

Successfully activated suppert for HPEG.

GMT 2020-01-29 12:37:50:341 Progress The HPEG Ground Mode ID was successfully set to 1.
GMT 2020-01-29 12:37:50:325 Info Uzer selected Ground Mode D 345 W
Configure... Clear... Expart... Delog...
Figure 14 Messages Dialog
Configure

The Configure button provides access to the Configure Messages dialog shown in Figure
15. This dialog provides access to preferences associated with messages. Display
preferences can be set to filter the types of messages (category) displayed in the
Messages dialog. Export Preferences control how the time tag is added to the filename
that is created when messages are exported. See the Export section for details. Message
storage defines the maximum number of messages that will be stored in memory while
the application is running. Once the maximum is reached, older messages are deleted to
make room for new messages. The Set to Defaults button can be used to reset these
properties to application defaults.

12
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.. Configure Messages

Messages Dialog Display Preferences

Info Frogress Warning Error [ | Debug

Export Preferences

[ When Exporting Messages Prepend the Timestamp to the Filename

Message Storage
Maximum Mumber of Messages Available for Display: “
Set to Defaults Cancel

Figure 15 Configure Messages Dialog

Clear

The Clear button provides access to the Clear Messages dialog shown in Figure 16. This
dialog provides two ways to clear application messages stored in memory. You can clear
all the messages or clear selected messages. Once you clear messages, the messages are
permanently deleted in all views (Main Window Message Area and the Messages dialog).

. Clear Messages 7

(®) Clear All Messages

() Clear Selected Messages

Corcel

Figure 16 Clear Messages Dialog

Export

The Export button provides the capability to save all the application messages currently
in memory to afile. When you push the Export button you will be prompted for a
directory and filename. Export will save all messages in memory, not just the messages
currently displayed in the Messages dialog (i.e. the Display Preferences are not applied).
The name you provide for the file will be modified with a time tag that is added to the
filkname. The time tag indicates the time the file was closed. The default is to append
the time tag to the filename. For example:

Filename Input: messages.txt
Filename Output: messages_2017-05-07_13~03~28.txt

13
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If you would like to prepend the time tag to the filename you can set this preference in
the Configure Messages dialog. This would result in the following:

Filename Input: messages.txt
Filename Output: 2017-05-07_13~03~28 messages.txt

Delog
The Delog button provides the capability to save all application messages generated since

the application was started. Delog will retrieve the messages from the temporary log file.
When you push the Delog button you will be prompted for a directory and filkname. A
timetag is not applied to the filename.

Filename Input: messages.txt
Filename Output: messages.txt

6.5 Manage E-Mail and Text Settings Dialog
The Manage E-Mail and Text Settings Dialog is shown in Figure 17. This dialog

provides the capability to manage global e-mail and text settings, application alert
settings, e-mail and text dropboxes, and the capability to send an e-mail or text.

. Manage E-Mail and Text Settings

Global Settings  Application Alerts ~ E-Mail and Text Dropboxes  Send E-Mail  Send Text
Allow Alerts [Global Control for all TRek Applications] Export...

Account E-Mail List Cell List Group List

SMTF Server Address: | |

E-Mail Account Username: | |

E-Mail Account Password: | | [ show

E-Mail Address: | |

E-Mail Mame: | |
[ verify Certificate Authorities

Certificate: Browse...

[] Enable Curl Debug Messages

oK Cancel

Figure 17 Manage E-Mail and Text Settings Dialog (Global Settings Account Tab)
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The TReK software’s e-mail and text capability is dependent on libcurl, an open source
client-side URL transfer library developed by the cURL project. The libcurl library
provides C API functions that configure the library to programmatically establish a
secure connection with an email server using a Transport Layer Security (TLS) version
1.3 socket prior to logging into anemail account using an email account name and
password.

The TReK email and text capability has been successfully tested with the Google gmail
server. Itis recommended that users create a new gmail account and use it to send emails
and texts to designated recipients. The TReK software does not support retrieving emails
from the user's gmail account. When creating the gmail account to send emails and texts,
the user must change the security settings under the "Manage your Google Account”
button under the user's "Google Account™ widget (found in the top right hand corner of
the user's gmail account web page). After choosing "Security" from a list of items found
on the user's "Google Account™ web page, the user must scroll down to the section on the
web page titled "Less secure app access"and turn on this access setting. This setting
enables the TReK software’s emalil library access to the user's gmail account using a TLS
socket that encrypts all traffic between the the TReK email library and the user's gmail
account including the user's account name and password. Google will automatically turn
this setting off if it’s not being used. After turning on “Less secure app access", users
will receive a warning message saying their account is vulnerable to malicious activity
because of a less secure sign-in technology and recommend turning off this type of
access. TReK recommends only using the account to send emails and texts using the
TReK software. TReK does not recommend using the account to receive emails.

The maximum size of a text message is approximately 900 characters. However, if you
send more than 900 characters your message may be broken up during transmission and
then concatenated on the recipient’s phone. The maximum length of a TReK email
message is 65,000 characters or bytes. The maximum length of an email with a file
attachment is generally considered to be 10MB (email message size plus file attachment
size). Note, file attachments may become much larger than their original file sizes. This
is due to the encoding employed by email servers when sending non text-based
information.

Global Settings

Global Settings are e-mail and text settings used in all TReK applications. They can be
changed in any TReK application with a Manage E-Mail and Text Settings dialog. When
you change a setting on the Global Settings tab, it will be changed for all TReK
applications. Each Tab is described below.

Allow Alerts

The Allow Alerts Checkbox is a global setting to turn on and off all alerts in all TReK
applications. If you turn this checkbox off, no alerts will be generated in any
applications.

Export
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The Export button provides access to the Export dialog shown Figure 18. This dialog
provides the capability to save the settings on the Global Settings tab in a TReK email
configuration file that can be used with the TReK E-Mail and Text API. You also have
the option to include the dropboxes defined on the E-Mail and Text Dropboxes tab.

i Export 7 3

Directory: | |

Filename: | |

Indude E-Mail and Text Dropboxes
Cancel

Figure 18 Manage E-Mail and Text Settings (Export Dialog)

Account

In order to use the Alerts capability, you must have a Gmail account. The Gmail account
must be configured to allow third party access. The Account tab is used to enter your
Gmail account information. The account password will be hidden by default and will be
encrypted when it is stored. It will only be decrypted when it is used to log into the
account to execute a requested function. An example of account information is shown
below.

smtp_server_address: smtp.gmail.com

email_account_username:  jane.doe@gmail.com

email_account_password: secretPassword [Hidden unless show checkboxis checked]
email_address: jane.doe@gmail.com

email_name: Jane Doe

The Verify Certificate Authorities checkbox is used to turn on the certificate authority
check. If you turn on the certificate authority check, you must provide the complete path
to a Certificate file.

The Enable Curl Debug Messages checkbox is used to turn on additional debug messages
generated by the curl software library.

E-Mail List

The E-Mail List tab is used to enter e-mail addresses that will be used to populate the e-
mail address list that is available when configuring alert functions or sending an e-mail.

The E-Mail List tab is shown in Figure 19. The Add button is used to add a row to enter
e-mail address information. The Delete button is used to delete a row.
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. Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Allow Alerts [Global Control for all TRek Applications] Export...
Account | E-Maillist  Celllist  Group List
E-Mail Address E-Mail Mame Add
John.Doe@gmail.com John Doe Delete
oK Cancel

Figure 19 Manage E-Mail and Text Settings Dialog (Global Settings E-Mail List Tab)

Cell List

The Cell List tab is used to enter mobile cell phone numbers that will be used to populate
the Cell list that is available when configuring alert functions or sending a text. The Cell
List tab is shown in Figure 20. The Add button is used to add a row to enter cell number
information. The Delete button is used to delete a row. Cell numbers can be entered
with or without dashes. The Set Carrier button is available when a Cell Carrier cell is
selected. Itis shown in Figure 21 and can be used to select a carrier address. If the
carrier address you need is not in the list, you can enter it directly into the cell.
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Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Allow Alerts [Global Control for all TRek Applications] Export...
Account  E-Maillist  Celllist = Group List
Cell Murnber Cell Carrier Add
236-335-T777 tat.att.net Delets
Set Carrier...
oK Cancel

Figure 20 Manage E-Mail and Text Settings Dialog (Global Settings Cell List Tab)

Set Carrier

Filter: v
Country Mame Address ()
American Samoa  Bluesky Comm... psms.bluesky.as
Argentina CTI Mavwil smsctimovil.corm.ar
Argentina Movistar sms.movistar.net.ar
Argentina Mextel TwoWay.11.nextel.net.ar
Aruba Setar mas.aw
Australia Optus Mobile optusmehile.corm.au
Australia Telstra online.telstra.com.au
Austria MaxMobil maxmail.at
Austria One Connect ocnemail.at W

Carrier: |

Cancel

Figure 21 Manage E-Mail and Text Settings (SetCarrier Dialog)

Group List
When configuring an application alert or sending an e-mail or text, you will have the

option to identify an e-mail address, a cell phone number, or a group as a recipient. The
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Group List is shown in Figure 22. You can define zero or more groups. A group can
contain e-mail addresses and cell numbers. If you have a group with both e-mail
addresses and cell numbers and you send an e-mail to that group, the e-mail generated
will only be sent to the e-mail addresses in the group. You can add, modify, and delete a
group using the buttons on the right.

. Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Allow Alerts [Global Control for all TRek Applications] Export...
Account E-Mail List Cell List Group List
Group List Add...
Team Modify...
Delete
oK Cancel

Figure 22 Manage E-Mail and Text Settings Dialog (Global Settings GroupList Tab)

The Add button will display the Add Group dialog shown in Figure 23. At the top you
can enter a name for the group. On the left you will see all the e-mail addresses and cell
numbers you entered on the Global Settings main E-Mail List and Cell List tabs. You
can add zero or more e-mail addresses and zero or more cell numbers to a group. To add
an e-mail or cell to the group, selectthe e-mail or cell number on the left and push the
Add button to add it to the group. You can use the Delete button to delete a recipient
from the group.
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Add Group
Group Mame:
E-Mail List cell List Group Members
Delete
John.Doe@gmail.com
Add ==
Cancel

Figure 23 Manage E-Mail and Text Settings (Add Group Dialog)

Application Alerts
The Application Alerts tab is shown in Figure 24. It is used to configure application
specific alerts.

Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Enable Application Alerts
Event Type Recipient Additional Text Add...
Lost Connection E-Mail Jehn.Doe@gmail.com Control Room Laptop 13579 Modify
Delete
Cancel

Figure 24 Manage E-Mail and Text Settings Dialog (Application Alerts Tab)

Enable Application Alerts
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The Enable Application Alerts Checkbox is used to turn all alerts on or off in the current
application. If you uncheck Enable Application Alerts, no alerts will be generated in the
Command application.

Event List

The Event area provides the capability to identify one or more alerts to send when a
specific application event occurs. You can add, modify, and delete alerts using the
buttons on the right. The Add button will display the Add Alert dialog shown in Figure
25.

L0 Add Alert ? X
Event: Lost Connection w
Type: E-Mail e
Recipient: John.Doe@gmail.com e

Additional Text: |

Cancel

Figure 25 Manage E-Mail and Text Settings (Add Alert Dialog)

Event

The Event is what triggers the alert. There may be one or more events in an application
that can trigger analert. The HPEG application can generate an alert for the following
types of events:

Lost Connection
This event is triggered if the HPEG connection to the HOSC is lost.

Type
The type of alert to send. Options are E-Mail, E-Mail and Text, or Text.

Recipient

The recipient identifies who should be notified when the event is triggered. The
Recipient list will be populated with applicable recipients based on Type. If you select E-
Mail in the Type menu, the Recipient list will be populated with e-mails from the E-Mail
List tab and groups that contain at least one e-mail address from the Group List tab. If
you select E-Mail and Text in the Type menu, the Recipient list will be populated with
groups from the Group List tab that contain at least one e-mail address and one cell phone
number. If you select Text in the Type menu, the Recipient list will be populated with
cell phone numbers from the Cell List tab and groups that contain at least one cell phone
number from the Group List tab.

Additional Text
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The alert will contain the name of the event that occurred and any text that is provided in
the Additional Text field. Additional Text is optional.

E-Mail and Text Dropboxes

The E-Mail and Text Dropboxes tab is shown in Figure 26. This tab can be used to
define E-Mail and Text Dropboxes. It is important to remember that each E-Mail and
Text Dropbox will correspond to a directory on the file system and must be unique.
Using a directory for more than one dropbox will result in unexpected behavior. When
you define a dropbox using the Manage E-Mail and Text Settings dialog, the dropbox
information is automatically saved with that specific application’s settings.

. Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Dropbox Type Dropbox Path Dropbox Success  Recipient State Add
Madify. .
Set Off
SetOn
Delete
oK Cancel

Figure 26 Manage E-Mail and Text Settings Dialog (E-Mail and Text Dropboxes Tab)

Dropbox List

The Dropbox List is used to define zero or more dropboxes. For each dropbox you can
define the Dropbox Type, the Dropbox Path, the Dropbox Success Path, a Recipient, and
a State. The buttons on the right can be used to add, modify, delete, or change the state
of a dropbox. The Add Dropbox dialog is shown in Figure 27.
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.\ Add Dropbox ? *
Dropbox Type: | E-Mail W
Cropbox Path: | | Browse...
Success Path: | | Browse,..
Redpient: John.Doe@gmail.com e
State: Off w

Cancel

Figure 27 Manage E-Mail and Text Settings (Add Dropbox Dialog)

Dropbox Type

There are three types of dropboxes: E-Mail, E-Mail File, and Text. An E-Mail dropbox
will e-mail the contents of a file placed in the dropbox. An E-Mail File dropbox will e-
mail the file placed in the dropbox. A Text dropbox will text the contents of a file placed
in the dropbox.

Dropbox Path
The Dropbox Path identifies the local directory to be used for the dropbox. The Browse
button can be used to select a directory.

Dropbox Success Path

The Dropbox Success Path is optional. If the Dropbox Success Path is defined, the
dropbox will move the original file placed in the dropbox to the success directory if and
only if the corresponding e-mail or text is successfully delivered to the e-mail server. If
the success path is empty, the dropbox will delete the original file placed in the dropbox
if and only if the corresponding e-mail or text is successfully delivered to the e-mail
server. If the dropbox fails to generate the e-mail or text, the file will be renamed with a
time tagged ".droperror" extension and remain in the dropbox. The dropbox will not
attempt to generate an e-mail or text for a file with a ".droperror” extension in its
filename.

Recipient

The Recipient identifies the designated recipient(s) for the e-mail or text. The Recipient
list will be populated with applicable recipients based on the Dropbox Type. For
example, if you select E-Mail or E-Mail File in the Type menu, the Recipient list will be
populated with e-mails from the E-Mail List Tab and groups with at least one e-mail
address from the Group List Tab. If you select Text in the Type menu, the Recipient list
will be populated with cell phone numbers from the Cell List Tab and groups with at least
one cell number from the Group List Tab.

State
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The state controls whether the dropbox is activated. It can be setto Off or On. If the
state is setto Off, the dropbox will not be activated. If the state is setto On, the dropbox
will be activated when you push the OK button. If the state is set to On when you exit
the application, it will automatically be activated the next time you run the application. If
you do not want the dropbox to be activated on application initialization, set the state to
Off before exiting the application.

Send E-Mail

The Send E-Mail tab is shown in Figure 28. This tab canbe used to send an e-mail if
valid information has been entered on the Global Settings tab. Once the To, Subject,
optional File (Browse canbe used to browse the local disk for afile), and Message
information has been entered, press the Send button to send the e-mail. This will initiate
a request to send the e-mail. Look at the main window message area for information
about whether the e-mail request was successful or encountered any errors.

. Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text
Tos John.Doe @gmail. com w
Subject: |
File: | Browse...
Message: Send

oK Cancel

Figure 28 Manage E-Mail and Text Settings Dialog (SendE-Mail Tab)

Send Text

The Send Text tab is shown in Figure 29. This tab can be used to send a text if valid
information has been entered on the Global Settings tab. Once the To and Message
information has been entered, press the Send button to send the text. This will initiate a
request to send the text. Look at the main window message area for information about
whether the text request was successful or encountered any errors.

24



TREK-USER-0005

. Manage E-Mail and Text Settings

Global Settings Application Alerts E-Mail and Text Dropboxes Send E-Mail Send Text

To: 256-555-7777

Messzage: Send

| oK | | Cancel

Figure 29 Manage E-Mail and Text Settings Dialog (Send Text Tab)

6.6 Advanced Settings

The Advanced Settings dialog provides access to configure several advanced settings.
The Advanced Settings dialog is shown in Figure 30.

Communication Timeout (miliseconds): | 10000 |

[ ] Log TReK HPEG Interface Messages

Log Directory: |C:/Usersfkirk

Log Filename: |trek_hpeg_interface_message_log. twt

I QK I | Cancel

Figure 30 Advanced Settings Dialog

Communication Timeout
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You canset the timeout value used in communication with the Huntsville Operations
Support Center. It is unlikely there would ever be a need to modify this setting. The
timeout value canonly be modified when the HPEG service is inactive.

Log TReK HPEG Interface Messages

The TReK HPEG application provides the capability to log messages that are exchanged
between the TReK HPEG application and the HOSC HPEG software to a file. This
capability has been provided for troubleshooting purposes. Hopefully this is a feature
you will never need to use. If you check the Log TReK HPEG Interface Messages
checkbox, the messages that are exchanged between the TReK HPEG application and the
HOSC HPEG software will be written to the log file specified. Message Logging will
start when the HPEG service is activated and stop if you uncheck the box or the HPEG
service is deactivated. Once a log file exists, any new messages will be appended to the
existing log file.

Log Directory
The Log Directory field should contain the absolute path to the directory where the log

file should be written.

Log Filename
The Log Filename field should contain the name to use for the log file.

6.7 Application Settings

The HPEG application saves application settings each time you exit the application. The
next time you run the application, the application will initialize with the previous settings.
Only one set of settings are saved. If you run multiple instances of the application, the

settings in the instance that is exited last will be saved. The following settings are saved:

Application Window Size
HPEG Port Entry

Firewall In Use Selection
Firewall 1P Address Entry
Firewall Port Entry

Firewall HPEG Port Entry
Configure Messages Selections
E-Mail and Text Settings
Advanced Settings

VVVVVVVVY

7 FAQ and Troubleshooting

This section addresses Frequently Asked Questions and provides tips for troubleshooting
common gotchas.

No FAQs Yet.
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